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» Your computer is a invaluable part of your
job search.

» Are you protecting your computer from
disaster?
—Virus, Spam, ID Theft, Spyware,

— Disaster (hard drive crash, loss of power,
power spikes and sags, fire, etc.)
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» There are many simple, inexpensive
approaches and some great FREE
software tools to help avoid disaster.
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o Always:

— use a surge protector or better yet an UPS
(uninterruptable power supply)

— use at least a software firewall and a
hardware firewall if available

— run anti-virus software and SPAM filters
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e Periodically:

— Run a complete anti-virus and anti-spyware
check of your system

— Run a defragmentation of your hard drive

— Run a program to clean up orphan files,
duplicate files and trash on your hard drive

— Run a check on the performance of your
computer to see if it is slowing down

— Run a check on your Internet connection to
see if it has slowed down
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— Clean out unused and out of date files and
applications

— Do not download every “FREE” tool bar or
gimmick that is offered; most contain malware

— Organize your files and keep them organized
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— Clean your keyboard and if your computer is
on the floor.
* Be sure to vacuum (not blow) the dust out.

» Be sure your computer is turned off (static
electricity)

— Do you turn your computer off each night or
leave it on?
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e Virus Protection

— Microsoft Security Essentials
* Replaced - Microsoft Window Defender in 2009

http://www.microsoft.com/Security Essentials/

— Avast Free Antivirus nipmmw.avast.com
- Spybot SeaI’Ch and DeStroy www.safer-networking.org/
— Kaspersky 2010 — If you want to purchase

- AVG FREE http://free.avg.com/us-en/homepage
* Do NOT recommend this program any more
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e Virus Protection
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e Virus Protection

— In addition to free software, several of these virus
protection software applications are available for
FREE or close to free using mail-in rebates. Watch
the ads at Fry's...something new each week. Itis a
small pain to fill out the rebates and follow up, but
worth it if to receive multi-user licenses for just a small
investment of your time.

— TIP: Carefully read the fine print on the forms and
MAKE COPIES OF EVERYTHING YOU SEND.
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« Email
— Web based
* Yahoo Malil
* Gmall (free POP)
* Hotmall
« AOL
— If you have a tx.rr.com or sbcglobal.net

account, what happens when you change
services...you lose you email address.
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 Email
— Web based vs Local based
* Web based...you can check mail on any computer
in the world.

* Local based (Window Mail, Outlook, Thunderbird)

— You must check ONLY on your local computer. You may
be able to check a web based version, but you will not
have your detalils.
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« Emalil

Your Computer

— Be careful where the web link sends you.

Chat & Mobile Text
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¥ 0 Mobile Contacts

You don't have any
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Not Listed? New Chat

[Hide]
Create Your New Account Profile

Dear Chase Member,
Your checking account billing information has been deleted during our recent upgrade
and maintenances of our database against Virus.

[Add]

To access it, just Sign in to Online Banking to update your billing information carefully.

http:
Thank you

cure.chase.com/update/fth/verify.asp
your patience in verifying your account information.

Sincerely,
Chase Mgfihattan Bank Customer Service
[Add]
sincerglff,
Mobile Text

Onlgle Services Team
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(Add - Edit] % GoPaperlessl Its fast, simple and secure. Sign up now

To see all of the Alerts available to you, please log on to www.chase.com.
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» Storage Back up

Your Computer

What should you back up?

 Everything that you use regularly or will
need in the long term
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« What do you use for a backup?

— Thumb Drives

— Portable Hard Drive

— DVD'’s of applications

« How to Back up

— Start > All Programs > Accessories > System
Tools > Backup

— CARBONITE ???
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» FREE software to use for a backup?

— Drive Imaging Backup Solution

» Paragon — Backup and Recovery 2011(Advance)
FREE - Total PC Protection for Serious Users!

» Take complete control of your PC’s safety. Based
on solid commercial backup and recovery software
from Paragon, the new Backup & Recovery 2011
(Advanced) Free Edition will give you a rich set of
features that you can trust.

» Smart people backup; Backup & Recovery is smart
backup.

¢ http://www.paragon-software.com/home/db-express/
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» FREE software to use for a backup?

— File Synchronization

» SyncToy 2.1 - a free application that synchronizes
files and folders between locations. Typical uses
include sharing files, such as photos, with other
computers and creating backup copies of files and
folders.

«  http://www.microsoft.com/downloads/en/details.aspx?displaylang=en&FamilylD=c26efa36-98e0-4ee9-
a7c5-98d0592d8c52

— Other online backup and synchronizations
programs are listed at:

http://www.pcmag.com/article2/0,2817,2361880,00.asp
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e How to speed up your computer
— Add RAM
* |nstall the maximum amount

« http://www.memoryx.net/

Some things to remember to have good success when upgrading
your RAM Memory.

[

Must know or get your Computers Manufacturing Make & Model name &/or model #.

2. Must open Computer Case, with power off of course, and find out how many slots your motherboard has to
handle your RAM. You might note which Memory slot is physically closer to the Processor chip. That square
thing with the funny looking, pokie, aluminum block heat sink or cooling fan on it. That slot is your Primary
memory slot and should always have the largest stick of memory if your memory sticks are different Ram
size. If they are the same size, all 1 GB, then no problem.

3. This would be great time to clean the Dust Bunnies out our your Computer. Use which ever method you
prefer. (| prefer to vacuum 1st; dust with camel hair brush [Ace; Lowes; Home Depot] to clean really dirty
areas; vacuum again; blow out; under chips & hard to get areas; and vacuum one last time.

4. Once you determine total RAM your Computer can handle divide that by number of slots to determine the
largest stick of RAM you can put in any one slot. ex) Your Computer can handle 2GB total and you have 4
slots. That means each slot can handle up to 512Mb of RAM per slot x 4 = 2 GB.

5. What | recommend is if you have the time and can stand to have your Computer down for hour or two, is

take a stick of your RAM out and take it with you to your favorite memory Store. (Frys; Radio Shack;

BestBuy, etc) That way you do not buy the wrong style; speed; and other details | could bore you with.
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 How to speed up your computer

— Other things you can do:
Start > All Programs > Accessories > System Tools

* Run Disk Cleanup
* Run Defragmenter
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« Want to know everything about your
computer?

- SIW

» Freeware Version stands for System Information
for Windows. This utility provides users with an
amazing array of information about your Windows
machine and its contents, performance, and
settings.

* You can download the program from CNET at:
http://download.cnet.com/SIW-Freeware-Version/3000-2094_4-
75179711.html?tag=mncol;3
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 Microsoft Office 2007 or 2010
— Can’t open .docx?

— If you are running Office 2003 and have not
up graded to 2007 or 2010, there is a FREE
compatibility pack you can add on to your
2003 program that will allow you to open 2007
and 2010 documents.

— MAKE SURE your updates are current.

—  http://www.microsoft.com/downloads/details.aspx?Familyld=941B3470-3AE9-4AEE-8F43-
C6BB74CD1466&displaylang=en
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» Microsoft Office 2007 and 2010

— One side note about Microsoft Office 2010.
Office 2010 products are significant different in
look and feel than previous Office versions.

— If you use Excel or Word in your job, start to
familiarize yourself with the new look and feel.
— Check out www.CareerDFW.org /
websites /
Other Useful Career Websites /
FREE Computer Based Training

http://careerdfw.org/J/websites/50-other-useful-career-websites/71-other-useful-career-websites.html

11
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 Open Office

— OpenOffice.org is the leading open-source office
software suite for word processing, spreadsheets,
presentations, graphics, databases and more.

— It works on all common computers. (PC & MAC)

— It stores all your data in an international open
standard format and can also read and write files
from other common office software packages.

— It can be downloaded and used completely free of
charge for any purpose.
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* Open Office
— Writer (Word)
— Calc (Excel)
— Impress (Powerpoint)
— Draw
— Base (Access)

— Download from www.OpenOffice.orqg

12
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* To hold awebinar — up to 20 people

— DimDim.com - Purchased by Salesforce.com
and will NO longer be free after 3/15/11
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 To hold awebinar — up to 3 people

— Adobe ConnectNow — Free

» Meet live over the web and share computer
screens.

» Take control of another meeting participant's
desktop with permission.

* Video conferencing - With a webcam, use
multipoint video for a real in-person feel to your

online meeting
« https://www.acrobat.com/?app=Ip&trackingid=COY SK#/connectnow/GoToMyMeeting

13
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 Need to find a good time to meet

— Doodle Easy Scheduler
» Schedule a poll or make a choice
» Send out the link to your group
* Individuals log in and enter their name and their
preferences
* You then know when you hold a meeting
* Sign up (FREE)

«  www.doodle.com
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 Need to find a good time to meet
— Doodle Easy Scheduler
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 Need to convert adocument to a .pdf

— doPDF72

* installs itself as a virtual PDF printer driver so after
a successful installation will appear in your
Printers and Faxes list. To convert to PDF, you
just have to print the document to doPDF, the free
pdf converter. Open a document (with Microsoft
Word, WordPad, NotePad or any other software),
choose Print and select doPDF. It will ask you
where to save the PDF file and when finished, the
PDF file will be automatically opened in your
default PDF viewer.

*  http://www.dopdf.com/
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 Need to convert from .pdf to Word

— PDF to Word

* you can quickly and easily create editable
DOC/RTF files, making it a cinch to re-use PDF
content in applications like Microsoft Word, Excel,
OpenOffice, and WordPerfect.

Best of all, it's entirely free!

« http://www.pdftoword.com/Default.aspx
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 Need to convert from .pdf to Excel

— PDF to Excel

* quickly and easily create highly-editable XLS files,
making it a cinch to re-use tables and
spreadsheets from PDF files in Microsoft Excel,
OpenOffice, Google Docs, and WordPerfect Office.
Best of all, it's entirely free!

« http://www.pdftoexcelonline.com/
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 Need to edit a .pdf file

— PDFHammer

* edit your PDF files online without installing a thing!
Simply upload PDF files to PDF Hammer via your
web browser, perform your edits, and then save the
files back to your computer. The online editor allows
you to view the pages of your PDF files as you edit

them.
— Combine PDF.
— Edit PDF pages. Quickly rearrange, reorder, and delete the pages from
existing PDF files.
— Secure PDF. Protect the contents of PDF files with password-based
security.
http://www.nitropdf.com/free/hammer/index.htm

16
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« Mac
— You will find many free downloads at Open

Source Mac

— http://www.opensourcemac.orq/
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 Restore Points

This is a component of Microsoft's operating systems that
allows for the rolling back of system files, registry keys,
installed programs, etc., to a previous state in the event of
malfunctioning or failure.

In System Restore, the user may create a new restore point
manually, roll back to an existing restore point, or change
the System Restore configuration. Moreover, the restore
itself can be undone. Old restore points are discarded in
order to keep the volume's usage within the specified
amount.

Start > All Programs > Accessories > System Tools >
Restore

http://en.wikipedia.org/wiki/System_Restore#Restore_points
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e Firewall

— This is a part of a computer system or network
that is designed to block unauthorized access
while permitting authorized communications.

— Itis a device or set of devices configured to
permit, deny, encrypt, decrypt, or proxy all (in
and out) computer traffic between different
security domains based upon a set of rules
and other criteria.
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e Firewall

— Firewalls can be implemented in either
hardware or software, or a combination of
both. Firewalls are frequently used to prevent
unauthorized Internet users from accessing
private networks connected to the Internet,
especially intranets. All messages entering or
leaving the intranet pass through the firewall,
which examines each message and blocks
those that do not meet the specified security
criteria.

—  http://en.wikipedia.org/wiki/Firewall
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* FREE Quick Reference Cards

— Free two page reference guides for many
programs

« http://www.customguide.com/quick_references.htm

— DO NOT register, just right click and save as a pdf file
any of the quick references.
Microsoft Access 2007, 2003,2002,2000..
Microsoft Excel 2007,2003,2002,2000,97

Microsoft FrontPage..

Internet Explorer...

Microsoft Office 2007

Microsoft Outlook 2007, 2003,2002,..
Microsoft Powerpoint..

Microsoft Windows Vista, XP, 2000, 98
Microsoft Word...

Macintosh..

Adobe...
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e Other FREE Programs

— Create, share and store your resume online
for free: nwpumwwemusecon (YOU CAN Manage job
submissions and add notes — all one line. All
you need is access to a PC — public
library/computer/friends computer)

— 10 best and free data recovery tools:

http://www.techmynd.com/10-plus-best-free-data-recovery-tools-downloads/
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e Other FREE Programs

— If you want to run applications from a USB
stick (you have what is called portable apps):

http://www.techiesouls.com/2008/10/30/15-most-useful-and-best-portable-apps/

(these are FREE. Everything under the sun)

— Easy way to get FREE applications: nupuninite.coms

— If you need OLD versions of applications:

http://www.oldapps.com/
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» To find this presentation on line...go to
www.CareerDFW.org
— Click on the File tab, scroll down to section

15. Your Computer, click on that and open the
file called Your Computer
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